
    Markku Seppänen 22-01-2010 

 

ScoreBridge  & Bridgemate käyttöohje  
 
 Normaali käyttö 

Pöytälaitteiden TD-toiminnot  
Ongelmatilanteita  

 
 
 
 
 
 
 
 
 
 
Liitteet 

 Ohjelmien asennus 
Scorebridgen perusasetukset 
Bridgemate PROn perusasetukset 
Scorebridgen softwaren päivitys 
Bridgemate PROn softwaren päivitys 
Serverin firmwaren päivitys 
Pöytälaitteen firmwaren päivitys 
 
 

  
 
 

 
 
 

 
 
 
  



Normaali käyttö: 

Laite-asennus 
 

1. Liitä serveri RS-liittimeen,   
2. Laita patterit serveriin (punainen valo syttyy serveriin) 
3. Liitä serverin virta-lähde verkkoon (virheä valo syttyy) 
4. Liitä serveri USB-porttiin (käytä aina samaa jos mahdollista) 
5. Liitä lisänäyttö tai videotykki RS-liittimeen, laita virrat päälle 
6. Kytke läppäriin verkkovirta 
7. Käynnistä läppäri   

  

Ohjelman käyttö 
1. Aseta näytön ominaisuudet 

a. klikkaa hiiren oikealla näytön taustaa 
b. avaa ominaisuudet 
c. avaa asetukset 
d. klikkaa ruutua 2  
e. klikkaa ”ruksi” Laajenna Windows-työpöytä tähän näyttölaitteeseen 
f. klikkaa  ”käytä” 
g. hyväksy OK 

2. Siirry oikeaan kerhoon alasvetovalikosta ”Club”, ellet jo ole siellä 
3. -> Events List 
4. -> New Event 
5. New Event Profile sivulla: 

 
a. Pairs ”ruksi” 
b. Number of tables pyöristettynä tarvittaessa ylös 
c. No of sections – ” 1 ” 
d. Use Bridgemates ”ruksi” 
e. Director ”nimi niin haluttaessa” 
f. OK 

 
6. Movement sivulla 

a. Jos Club standardit on valittu, klikka sitä ja valitaan movement sieltä  
b. Näkyviin tulee esim 8R kubk24, klikkaa sitä 
c. Tarkista jako/kierroslukumäärä- muuta tarvittaessa 
d. tulosta tarvittaessa Table Cards 
e. klikkaa OK 
f. Onko lepopari, jos on vastaa kyllä. 
g. Katso pöytäkortista mikä pari puuttuu, jos 2 pöytää pelaa samoja jakoja valitse niistä toisen 

paikallaan istuvan parinro  
h. Vahvista puuttuvan parin numero 
i. Vahvista movement ja puuttuva parinro 

 
7. ScoreBridge Bridgemate control-sivu aukeaa  

a. Ohjelma kysyy ”Use an Existing.bws Database? 
b. Vastaa edelliseen aina ”EI” 
c. Movementit on lähetetty Wireles Databaseen, hyväksy OK (oikeasti ne ei ole lähteneet) 



8. Bridgemate Pro control ohjelma käynnistyy 
a. pienennä ohjelman näkymää oikeasta ylänurkasta 
b. movementit ovat nyt lähteneet pöytälaitteille, mikä näkyy vasemmassa reunassa 

 
9. Pöytälaitteet ovat nyt syöttövalmiina pelaajatietoja ja tuloksia varten 

 
10. Tarkistettavat  

a. Pelimuoto 
i. Klikkaa taustalla olevaa ScoreBridgeohjelmaa ja alemmasta ylävalikosta klikkaa 

Score sheets 
ii. Hyväksy muistutus siitä, että Scorebidge ohjelman puolella käynti keskeyttää 

päivittämisen ja retrieving ja updating on käynnistettävä uudelleen 
iii. Valitse oikea laskentametodi, yleensä 3pöytää ”cross imps”,   4 tai enemmän 

”Match points” 
iv. klikkaa alemmasta ylävalikosta ”Other Pages” ja ”Bridgemate Control” 
v. klikkaa Continious Score Retrieval ”Retrieving”  ja Scrolling Results ”Updating” 

vi. ohjelma kysyy halutaanko näyttä tasoituksellisia tuloksia, yleensä ”EI” 
vii. selainohjelma avautuu avaten sivun rolling.htm 

viii. sivulle alkaa tulla nimet ja tuloksia vasta kun on joitain vertailukelpoisia tuloksia 
syötetty pöytälaitteisiin. 

ix. vedä sivu lisänäytölle tai videotykille 
x. ohjelma on valmis tuloksia varten 

 
b. Pelaajat 

i. klikkaa alemmasta ylävalikosta ”Other Pages” ja ”Allocation of namesto tables” 
ii. Hyväksy muistutus siitä, että Scorebidge ohjelman puolella käynti keskeyttää 

päivittämisen ja retrieving ja updating on käynnistettävä uudelleen 
iii. Lisää puuttuvat pelaajat klikkaamalla tyhjää paikkaa  luettelossa ja kirjoita vähän 

etunimen alkua ja valitse sitten oikeanpuoleisesta listasta oikea nimi. Lepoparia ei 
tarvitse merkitä mitenkään (ei koske Swissejä joihin on tehtävä lepo1 ja lepo2 tms 
pelaajat). 

iv. Lopeta ”OK /save” 
v. klikkaa  Continious Score Retrieval ”Retrieving”  ja Scrolling Results ”Updating” 

vi. ohjelma kysyy halutaanko näyttä tasoituksellisia tuloksia, yleensä ”EI” 
vii. selainohjelma avautuu avaten sivun rolling.htm 

viii. sivulle alkaa tulla nimet ja tuloksia vasta kun on joitain vertailukelpoisia tuloksia 
syötetty pöytälaitteisiin. 

ix. vedä sivu lisänäytölle tai videotykille 
x. ohjelma on valmis kilpailua varten 

   
11.    Kilpailun valmistuttua 

Scrolling näyttää, että All Boards Played 
Web-sivun teko 

Results and Outputs sivulta valitse alemmasta ylävalikosta ”Make ” ja ”Web 
page” 
Mikäli jakotiedosto on olemassa valitse Hand record file. 
Ellei jakotiedostoa ole peruuta   
Ohjelma ilmoittaa minne websivu on talletettu   

 
 Web –sivun postaaminen nettisivustolle onnistuu esim Firefoxin ftp-ohjelmalla 
 Sulje ohjelmat järjestyksessä   Bridgemate PRO -> File -> Close -> Exit 

ScoreBridge  -> Close Event 



Pöytälaitteiden käyttö TD-avaimella 
 
Laitteet ovat aina päällä. Niiden tiedot myös säilyvät kunnes tulee serveriltä uusi movement.  
TD-keytä käytettäessä on tärkeä huomata, että toiminnot riippuvat siitä mikä näyttö on esillä  
avainta sisään laitettaessa. 
Huom! Älä koskaan työnnä TD-avainta serverin kannessa olevaan vastaavan kokoiseen aukkoon. 
 

1. Asetusten tarkistus ja muuttaminen 
 paina OK, näkyviin tulee laitteessa oleva versio, esim: 
  BRIDEGMATE PRO 
  v2.3.1aEN 
 paina OK näkyviin tulee laitteessa olevat asetukset 
  SECTION:  A 
  TABLE:  1   
 jos halut muuttaa section ja table arvoja, odota kunnes laite sammuu ja paina OK. 
 
 Näkymän ollessa   
  BRIDEGMATE PRO 
  v2.3.1aEN 

työnnä TD-key sisäään.  
 
Section arvoa voit muuttaa + ja -  näppäimillä hyväksy OK:lla jolloin voit poistaa väärän 
pöytänumeron ja kirjoittaa tilalle oikean, hyväksy OK:lla. Hyväksy seuraavan sivun Channel 
(0) OK:lla 
 

2. TD-key:llä suoritettavat  muut toimenpiteet: 
 Näkymän ollessa  

BOARD: 
CONTR: 
työnnä TD-key sisäään, Näkymä muuttuu   

 
  BRIDEGMATE PRO 
  v2.3.1aEN 

paina 2 / SHOW RESULTS? /  OK ohjelma kysy jakoa, anna jakonro voit selata jaon tulokset 
paina 3 / ERASE RESULT? /BOARD: anna poistettava tuloksen jakonro/ OK 
paina 4 / STATUS / OK saat näyttöön Section ja Tablen, uusi OK pöydän jaot ja parinumerot 
paina 5 /MISSING BOARDS? /OK näyttää pöydän pelaamattomat jaot kyseisellä kierroksella 
paina 10/RESET?/ OK resetoi pöytälaitteen 

 
3. Prosenttituomion asettaminen  

Näkymän ollessa  
BOARD:     5                               Huom! jakonumero pitää hyväksyä OK:lla 
CONTR:      _ 

paina 1 / ARBITRAL SCORE? / näyttöön tulee  
  NS:                                anna tähän 4,5 tai 6  (=40% 50% tai 60%) ja OK 
  EW:                           anna tähän 4,5 tai 6 ja OK 

Poista TD-key, näytä NS:lle ja anna EW:n hyväksyä tulos 
 
 
  



Ongelmatilanteita 

Yleistä BM toiminnasta 
Pöytälaitteeseen syötetyt tiedot tallentuvat ensiksiki pöytälaiteeseen, sitten tiedot siirtyvät serveriin, jonne 
ne tallentuvat, ScoreBridge laskentaohjelma käynnistää Bridgemate PRO ohjelman, joka hakee serveriltä 
tiedot tallentaen ne sekä Bridgemate-hakemistoon BWS-tiedostoksi että Scorebridgen dat-tulostiedostoon. 
Tämän lisäksi serverille tulleet tiedot tallentuvat lokitiedostoon, joka löytyy BMPRO ohjelman ylävalikon 
tools ->Show log file tai suoraan c:/program files/Bridgemate Pro/PMProLog.txt. Tähän tiedostoon 
tallentuvat kaikki tapahtumat ja siitä on helppo jälkikäteen tarkistaa, mitä on tapahtunut.  

Näin siis tieto voidaan hakea viidestä paikasta: 
1. Pöytäkone 
2. Serveri 
3. BWS-tiedosto 
4. ScoreBridgen  dat-tiedosto 
5. Loki 
 
Edellisen mukaan voidaan ladata toisesta tallennuspisteestä tiedot seuraavasti:  
1) Tietokoneesta virrat poikki Serveristä ladataan tiedot uudelleen   
2) Serveristä virrat poikki  Tietokoneesta tiedot takaisin serveriin 
3) Molemmat tökkii   Siirretään lokitiedostosta tiedot laskentaohjelmaan käsin 
4) Pöytälaite ei toimi  Konfiguroidaan toinen laite tilalle  
 

 

Tietokoneesta virrat poikki 
  
Varmista ettei samalla myös serveristä katkea virta. ( Muistathan käyttää serverissä pattereita!)  
Kytke koneeseen virta ja käynnistä Scorebridge.  
1) Etsi ja klikkaa keskeytynyt kilpailu ja ”Retrieve Event”. 
2) Do you want to connect to the Bridgemate database ( …….    )?       vastaa ”Kyllä” 
3) Do you want the Scrolling screen  to show the Handicapped results? vastaa ”EI” (yleensä) 
4) Näkyviin tulee Results an Outputs sivu, klikkaa ylävalikosta ”Other Pages” ja ”ScoreBridge Bridgemate 

Control” 
5) Ylävalikosta  ”Restart” valitse ”Restart Reading results”  . Hyväksy ”Kyllä” 
6) Ylävalikosta  ”Restart” valitse ”Restart Wireless Program”  . ÄLÄ hyväksy vaan ”EI” 
7) klikkaa Continious Score Retrieval ”Retrieving”  ja Scrolling Results ”Updating” 
8) jos rolling ei päivity avaa Ylävalikosta  ”Restart” valitse ”Restart Scrolling results screen”  . Hyväksy 

”Kyllä” 
 
Kuten yllä olevasta käy ilmi sisältyy korjaustoimintaan epäloogisuutta.  

 

Yhteys tietokoneen ja serverin välillä poikki 
 
Yhteyden tila voidaan tarkistaa BridgematePROn vasemmasta ylänurkasta, pitää lukea  ”Connected” 
Yhteyskaapelin päässä olevassa murikassa pitää vilkkua keltainen valo.  
 
 



Serveristä virrat poikki   
       (siis patterit unohtui) 

 
1. Pyydä pelaajilta, että tulokset hetkeksi kirjataan ylös paperille 
2. Kytke virta uudelleen ja/tai laita patterit paikoilleen 
3. ScoreBridgen  ylävalikosta  ”Restart” valitse ”Restart Wireless Program”  . Hyväksy  ”Kyllä” 
4. Voi seurata erinäköisiä ilmoituksia, hyväksy ”Lastly click OK  …” 
5. tulee info:” Voi olla, että joitain pöytälaitteita jouttu resetoimaan . Jo BM kysyy sen jälkeen 

pelaajanumeroa, pitää vaan painaa ”OK” eikä missään tapauksessa pelaajnumeroa.” 
6. Klikkaa tähän infoon ”OK” 
7. Siirry PM PRO-ohjelman puolelle,  
8. Ylävalikosta ”Session” valitse ”Synchoronize client <-> server” 
9. klikkaa ”Synchronize” 
10. klikkaa  ”Close” 
11. klikkaa välilehti ”Recovery”  ja ”Recover server” ja hyväksy ”Kyllä” 
12. ohjelma tarkistaa, ettei kyse ole vahingossa ja pyytää antamaan tarkistusnumeron, anna se ja sulje 

report 
13. Kojeessasi olevat tulostiedostot ja movementit on siirretty nyt takaisin serverille 
14. Klikkaa Continious Score Retrieval ”Retrieving”  ja Scrolling Results ”Updating” 
15. Pyydä pelaajia syöttämään nyt paperille kirjaamansa tulokset.  

Pöytälaite ei toimi 
 
1) Pöytälaite ei näytä mitään. Vaihda patterit. Aseta vapaa pöytälaite kyseisen sijaan 

2) Pöytälaite näyttää kysyvän jakonumeroa kun sen pitäisi kysyä pelaajien numeroita. Tällöin annetaan 
vaan jokin numero ja OK jolloin pöytälaite saa oikean infon serveriltä ja siirtyy kysymään 
pelaajanumeroita normaaliin tapaan. 

 
3) Pöytälaite näyttää ”SYSTEM NOT ACTIVATED”.  

a) Tarkista yhteydet kojeen ja serverin välillä sekä serverin virransaanti 
b) Jos yhteys ei jostain syystä ollut päällä, sammuta tällöin BMPRO-ohjelma  ja käynnistä 

i) Kilpailun uudelleen (deletoi ensin samanniminen kilpailu) ja  
ii) Scorebridge uudelleen tai 
iii) sammuta läppäri ja käynnistä koko show uudelleen   

c) Tarkista pöytälaitteen pöytänumero 
d) Tarkista pöytälaitteen käyttämä kanava, ks ”Pöytälaitteiden käyttö TD-avaimella” kohta 1. 

 

Tulosten lataaminen suoraan pöytälaitteista 
Jos tuloksia on syötetty pöytälaitteisiin, ne säilyvät siellä jaa ovat helposti ladattavissa ohjelmaan 
seuraavasti: 

1. Bridgemate PROssa ylävalikosta valitse Session -> ”Read Bridgemate manually”  
2. Kytke yhteyskaapeliin kulmikas liitin ja johdon toinen pää pöytälaitteeseen    
3. Paina ruudulla OK,  paina pöytälaitteessa OK . 
4. Siirrä seuraavaan pöytälaitteeseen ja toista kaikkiin. 



 

 

Yleisesti ei vaan toimi 
  
Laite- ja ohjelmayhdistelmässä on selkiytymättömiä ilmiöitä, joiden hoitamiseen on toistaiseksi tehonnut  
vain virrat pois menetelmä. Katso että liitännät ovat OK, sammuta kaikki virrat, myös akku pois, ja käynnistä 
uudelleen. 
 
 
 

 
  



Liitteet 

Ohjelmien asennus 
- Scorebridge  netistä 

 
- Bridgemate pro CD:ltä,   

o käynnistys CD:n setup.exe 
 

- RS-liittimen driveri CD:ltä,  
o liitä laite kojeeseen ja anna windowsin asentaa CD:ltä 

 
 
 
 
 
 
 
 

ScoreBridgen perusasetukset 
 
1. Käynnistä ScoreBridge   

 
2. Siirry oikeaan kerhoon alasvetovalikosta ”Club”, ellet jo ole siellä 

Huomaa, että eri kerhoilla voi olla eri asetukset. 
 

3. Aseta Event Profile Preferences:  
 

 

 
 

  



4. Aseta Wireless Scoring Preferences seuravasti 
 
 

 
 
 
 
 

5. Aseta WeB Page Preferences 
 
 

 
 
 

 
 



Bridgemate PROn perusasetukset 
 

1. Alueen asetus 
valitse ylävalikosta ”Server” -> Region selection, aseta ”Europe” 

2. Kanavan asetus 
valitse ylävalikosta ”Server” -> Channel selection, aseta ”0” 

3. Tulossivun sarakkeiden valinta 
valitse ylävalikosta ”Tools” -> Show/hide columns, poista ruksit columneista:  
a) Declarer  
b) NS/EW 
c) Contract  
d) Result  
e) Lead  

4. Muut asetukset.  
Asetukset voidaan antaa joko Bridgemate PROssa tai ScoreBridgessa. Valinta ja asetukset tehdään 
kohdassa Bridgemate PRO -> Tools -> Options -> Bridgemate 

Scorebridgen softwaren päivitys 
Aloitussivulta ylävalikosta  ”System”  -> ” Download and install latest Scorebridge upgrade” 
Toimi ohjeen mukaan. 
 Huom! Älä tee päivitystä, ellei  support ja permanent lisenssit ole voimassa, sillä ohjelma lakkaa 
toimimasta kokonaan. 

Bridgemate PROn softwaren päivitys 
 
1. Lataa sivulta http://www.bridgemate.com/support.php?subpage=Download&subpageitem=Software   

 Bridgemate Control Software  update 2.0.17 (1.3MB)  
 

2. Tallenna updateohjelma kojeelle paikkaan, josta se helposti löytyy 
Käynnistä ohjelma ja asenna se entisen päälle vastaamalla OK tarvittaessa. 

Serverin firmwaren päivitys 
 
1. Lataa sivulta http://www.bridgemate.com/support.php?subpage=Download&subpageitem=Firmware      

 Bridgemate Pro server 1.2.6  (366 kB)  
 

2. Tallenna ohjelma kojeelle paikkaan, josta se helposti löytyy 
3. Liitä server USB-porttiin, varmista että serverissä on virta päällä 
4. Käynnistä ohjelma ja asenna se entisen päälle vastaamalla OK tarvittaessa. 

Pöytälaitteen firmwaren päivitys 
 
1. Lataa sivulta http://www.bridgemate.com/support.php?subpage=Download&subpageitem=Firmware  
2. Bridgemate firmwaren alta (tällä hetkellä uusin)   EN232a.bpf English version 
3. Tallenna kojeelle paikkaan, josta se helposti löytyy 
4. Avaa Bridgemate PRO -> tools –> Bridgemate -> Update firmware 
5. Liitä yhteyskaapelin vilkkuvaan päähän kulmikas liitin ja laita sen johdon toinen pää pöytälaitteeseen. 
6. ruudulla hyväksy OK .  
7. Paina pöytälaitteen OK, päivittyminen näkyy ruudussa. 
8. Vaihda seuraava pöytälaite ja paina taas OK, Toista kaikkiin pöytälaitteisiin 
 


